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Introduction 
Loopcloud is an application and subscription service the provides instant access to a 
whole host of content from the Loopmasters store. Users have a choice of content to 
purchase using points as well as free content which is updated with every new pack that 
is released. Browsing, purchasing, downloading and editing becomes one seamless 
process for creators to easily access files before importing into a DAW project. For users 
who have purchased content from Loopmasters before, your content will automatically 
appear in Loopcloud after logging in. You are also able to import any files from your own 
personal library, consolidating your sample library in a single location. Whether samples 
are local or in the cloud, your files are at your command alongside comprehensive 
editing functions. All of which serve to lower hard drive usage and accelerate your 
workflow. 

Use Loopcloud to browse your existing samples and download new ones. We want you 
to be able to find the sound you’re looking for quickly and easily. Therefore, all files 
within Loopcloud use our tagging system to help you find what you need.  

Compressed previews stream quickly over the internet and as soon as you download the 
files, the original full-quality uncompressed version is available. You can drag single or 
multiple files directly from Loopcloud into your music software or chosen location. The 
Loopcloud plugin allows you to preview audio in sync with your DAW. This makes 
selecting and editing samples to fit your project much easier to do on the fly.  

We also provide a number of free sample downloads per day; with these you can 
download any file marked as ‘FREE’ in the Loopcloud store. 
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Why use Loopcloud? 
Loopcloud lets you search millions of sounds from Loopmasters quickly, plus any sounds 
you have on your down hard disk, then preview them in the context of your track.   

The previews will be in-time, in-key, in a rhythm or arrangement of your choice and with 
any effects from your DAW or Loopcloud applied.  

Loopcloud makes finding, managing, and previewing samples fast and fun. 
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Getting started 
Create an account at loopcloud.com 

Download and install the software. 

Run the Loopcloud app, and log in. 

If you already have sounds on your Loopmasters account then you will need to wait 
while the library database is downloaded, this only happens once but you will have to 
wait for it to finish before continuing. 

Open your DAW, add the Loopcloud plugin to a track. 

Set the pitch adjustment to AUTO and change the key to match your track, that way 
Loopcloud will automatically re-pitch any file you select. 

Search for samples using the search box in Loopcloud.  Loopcloud will get you the best 
results if you select tags, or use a text search to bring up the auto complete menu and 
then select tags. By default, Loopcloud will search from your own content and the 
Loopcloud store samples.  

You can select samples and they will play in time and in-key with your DAW session.  

When you have found the sample you want to use, drag from the Export button to your 
DAW to import it. Exporting will create an audio file of your current mix. This will export 
all the Loopcloud tracks as one audio file, including any edits made in the loop editor – 
such as time stretching and pitch adjustments. You can change the export type by 
clicking the gear icon next to the Export button. 

Loopcloud offers many free sounds each day and is of course free to use with your own 
samples, but you can access the whole catalogue of millions of sounds if you buy a 
subscription. 

Other Loopcloud features include: 

• Editing loops and adding effects in order to create new loops. 
• Browsing by sample pack. 
• Applying predefined preview patterns (these are great with one-shots). 
• Adding your own tags to sounds. 

And much more – read the rest of the manual for the full details! 

https://www.loopcloud.com/cloud/registration
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Installation and system requirements 

System requirements  

Mac OSX  
• OSX 10.10 and later  

• 64-bit standalone application, 64-bit plugins. 

Windows PC  
• Windows 8 and later  

• 32-bit and 64-bit support  

The loopcloud preview plugin is available in 32 and 64bit versions on the PC.  An AAX 
version is available. 

Loopcloud instrument plugins are 64-bit only. 

Installation 

• Download Loopcloud from https://www.loopcloud.com by following the ‘Try 
Loopcloud Free’ button. 

• Double click the installer (it should be in your downloads folder). 
• Follow the on-screen instructions to complete the installation. 

PC users will have the option to specify a location for the VST plugins. 

Once the installation has finished open the Loopcloud application. 

On Mac it’s in your Applications folder. 

On Windows you have the option to use a desktop shortcut or you’ll find it in the start 
menu. 

Components 

Loopcloud includes: 

• The powerful Loopcloud application 

• A preview plugin you can use to preview loops in sync with your DAW. 
• Loopcloud Play – a multi-sample based instrument 
• Loopcloud Drum – a sample based drum machine with sequencer.  

Internet connection 

When you first start Loopcloud, you need to be connected to the internet so that you 
can log in and download the database of your sounds. (This is a list of all the sounds and 
tags – you can download the sounds themselves later).  

The Loopcloud app and plugins can be used offline once the database download is 
complete. Only sounds downloaded to your local disk will be available.  

The performance when listening to previews and downloading sounds will be better 
with a fast internet connection.  

https://www.loopcloud.com/
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Performance 

The speed of search results dependends on the size of your sample library and how 
powerful your computer is. Here’s a rough guide to performance:  

 

Note: 
You may want to exceed the recommended specification, if you have heavy DAW 
sessions running simultaneously with Loopcloud.  

Licensing and limitations 

You can use Loopcloud on up to two machines that you own. 

If you require more installations of Loopcloud please check our subscription plans here 
to upgrade.  

Pro subscribers have access on up to four systems. 

All sounds and samples in Loopcloud are royalty free. So, you can use any sound you 
download in your tracks, even if you make money from the music. For more information 
review the Loopmasters Licence.  

First login 

When you first open Loopcloud you will be asked to log in. Enter your e-mail and 
password – use the same account details as your loopmasters.com account.  

If you do not yet have an account with loopmasters.com 
then follow the Need an account? link to the right of the 
login window. 

Loopcloud will then download all the data about your 
content (instrument and genre tags, BPM and key, etc). 
Loopcloud does not download any actual samples in 
this process, just the tag data for each sample.  

 

You must let this download complete, or you will 
have to restart the download when next open 
Loopcloud. Depending on the size of your library 
and internet speed, this may take a while, but it 
only needs to be done once. 

https://www.loopcloud.com/cloud/plans
http://support.loopmasters.com/knowledgebase/articles/388556-loopmasters-license
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Getting started 

After you have logged in for the first time, a window will pop-up welcoming you to 
Loopcloud. This will outline five steps to get you started. We highly recommend new 
users following through this tutorial to understand the basic Loopcloud functions. After 
finishing, you’ll be set up with Loopcloud connected to your DAW, have your own 
sounds imported and have conducted your first Loopcloud search. 

Support sidebar 
Come back to this tutorial any time in the 
support sidebar. Click the question mark 
icon in the sidebar menu. Select Open First 
Steps.  

You can also find a variety of other useful 
resources here.  

Get Support will take you to the Loopcloud 
support portal. Here, you can contact 
support or access the knowledge base. Use 
if you come across any bugs, or have any 
feature requests. 

Some of the FAQ’s are listed in the support sidebar (under Support Articles) to make 
troubleshooting easier. You can also access our tutorial videos by selecting Watch 
Tutorials. 
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Searching for sounds 

 

Sounds in Loopcloud are tagged with instruments, genres and so on.  Click on a tag 
from the drop-down INSTRUMENTS tab to run your first search.  You can however also 
type a tag name into the search box, or search by many other criteria.   

If you type text into the search box which doesn’t match a tag it will search for files or 
folders with that text in their name.  

Search box 

 

The search box allows you to look for words, numbers or symbols that appear in file 
names. When you type a word in the search bar that is close to a tag, Loopcloud will 
auto-complete and replace the text with the closest tag. 

If you would like to cancel the auto-complete then type the word you would like to run 
in the search and click in the text box before running the search. However, to remove 
this feature permanently, uncheck the Auto-complete tags option. 

However, Loopcloud provides comprehensive tags for all sounds. Therefore, using tags to 
search will help you find the sound you are looking for quickly and easily. 

Tag filter 

 

Tags are organised into categories listed in the app header, just below the search bar 
(e.g. INSTRUMENTS, GENRES etc.). Each is a dropdown menu that contains all the tags 
within that category.  

Select a tag and it will appear in the search bar. Any subsequent tags added will appear 
alongside those previously added. 

Select Guitar from the instruments tab and House from the genres tab to show all 
guitars with the house music tag.  

If you select multiple tags within a category (e.g. guitar and keyboard) then you’ll see 
results that match both those tags. So, results will show sounds tagged with Guitar and 
Keyboard.  
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To clear individual tags either re-click a tag that has already been selected in the drop-
down menu; or click the x next to the tag icon in the search bar. 

Tags are grouped into categories and sub-categories. So, you’ll notice the Bass tag 
highlighted in blue, this is a parent category. Every tag under the Bass, i.e. Bass Guitar 
and Sub, are sub-categories of the Bass tag. Note, if you use a parent category, it will 
include results from all sub-categories. So, searching for Guitar will include acoustic 
guitars, banjos etc. 

Audio Filters 

You can now refine your searches within 
Loopcloud using the Audio Filters from the 
sidebar. This can be great for finding the sound 
that is in your head in the Loopcloud Store. 

Filters can be applied to your search or to help 
filter through a sound pack.  

Each time a filter is applied, the range will 
appear in the search bar. Click the X on this, the 
same way you would clear a tag, to reset the 
filter. 

You can also reset filters by double clicking the 
filter range in the audio filters sidebar. If you 
double-click the same filter range it will return 
to the previous values. Drag a filter range to 
adjust the values without changing the range 
size. 

Note: you can also show the audio attribute 
value applied to each sound in your results bar 
by adding the column to your results. 

Key 
All melodic content will be tagged with a 
musical key, e.g. F# minor 

Click on any key on the keyboard UI, and then 
either the MAJOR or MINOR to show results 
within that specific key. 

Note: 
If auto-key is selected in the loop editor, then the pitch of a sample automatically adjusts 
to fit the key of your track. This applies to all sounds with key tags. 

Tone 
Filter the results based on the target tone or frequency. For example, if you are looking 
for a bass sound then move the slider to just cover the bass frequencies. This is 
calculated based on the frequencies covered in the sound. When moving filter slider, 
you’ll see the frequency (Hz) appear above the node.  
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Length 
Use this to only show sounds of a certain length. Each slider controls a value in 
milliseconds (ms) from 60ms to 1 minute.  

Stereo Width 
Filter by stereo according to the width of the stereo image. For example, if you want to 
remove any mono sounds from your results. The slider is filters based on a percentage of 
stereo width. 

Loops 
In the loops section you can focus on the type of loop you are looking for. This section is 
not applicable to one-shot sounds. 

BPM  
You can set a BPM range to only show files that have a BPM within the set range. For 
example, if you are working on a House track you may want to set the range between 
110 and 125.  

Files are automatically adjusted by Loopcloud to meet the target tempo. However, this 
feature allows you to find results that are close to your target tempo. That way you can 
avoid sound artefacts from the time stretching process. 

Match Tempo 
When you have the Loopcloud plugin in your DAW, press the MATCH TEMPO button and 
Loopcloud will filter all BPMs within + or - 10BPM of your DAW tempo. With no DAW link, 
the range will set to the BPM of your Loopcloud session.  

Swing 
Use this to find sounds with a straight groove or a funkier swing. 

Rhythmic Density 
This is useful for filtering categories with a broad range of results. For example, if you’re 
looking for a big drum loop with many percussive elements – adjust the slider to only 
show more complex sounds from the results. 

One Shots 
Fine tune the type of one shot you are looking for by adjusting these speed parameters. 

Attack 
The speed from the start of the sound to its loudest peak. 

Decay 
The length of the sound’s tail. 

Filter results bar 

 

The filter results bar contains a set of buttons that are common to most searches. Find it 
just above the search results. Utilise these to make any quick changes to your search. 

Store/Library buttons 
When you run a search, Loopcloud will automatically show results from both the store 
and your library. Deselect either of these in order to show one or the other. 
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Loops/One-shots buttons 
Select one or the other to only show loops or one-shots.  If nether are selected, then both 
loops and one-shots will be shown. 

Show favourites 
Click a heart icon to mark a sound as favourite. Select this filter to only show results that 
you have favourited. 

Randomise results 
To quickly change the order of the results, use the randomise button.  

When not selected, files will be returned in the order they are stored in the database - so 
sounds from the same pack are more likely to be grouped together.  You can also sort, 
once searching has finished by any of the columns in the search results. 

Show downloaded items only 
This will automatically be selected if the app is running without any internet connection. 

When selected, only content that is available on your computer (your user-content and 
any files you have already downloaded) will be returned.  Use this if you are working 
offline; if your internet connection is slow; or you are just looking for content that you 
have already downloaded.  

This button appears as a little monitor screen icon – to the right of the randomise icon. 

WAV button 
When selected only WAV files are shown. Otherwise all formats of files are shown, 
including non-audio files such as synth presets.  

Show FREE content only 
With this selected the results of your search will only show files that can be purchased 
for zero points (as part of your free allocation of sounds). 

Show relevant product results 
This will hide/show the relevant products bar. 

When you run a search, a list of packs will appear in a bar above the search results – 
titled Relevant products. These all contain at least one file from the search results. 

 

You can use the arrows in the top right to scroll through some of the packs. Select Show 
All to just see a list of all available sound packs from your search results. 

Show detailed results 
There are two view types for search results. One has smaller rows and shows more files 
on the screen.   
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Get more results 
The Loopcloud store will in most cases produce a vast number of results for your search. 
To load the complete results would take a long load time. Therefore, each search 
produces a limited number of store results.   

Click get more results to ask the server to show you more store results. 

Note that we always return all the possible results from your local library, including your 
own content and anything you’ve purchased from the store.   

Note: The WAV button and Randomise results options will be the same for every new 
search until they are changed. Meanwhile all other options will reset on a new search.  

Search for similar sounds 

If you find a sound that you like, you can search for sounds that have similar properties. 
Making it easier to find the right sound or matching sounds. 

Click the icon under the match column in your results to select a similar search. You can 
also access this by right clicking a sound and going to the Search menu.  

Selecting one of the options will open a new search and change to a new Loopcloud 
track. 

 

Find harmonic matches 
Loopcloud will find sounds that are harmonically compatible with your source sound. 

Find rhythmic matches 
Flesh out your rhythmic ideas by finding loops or one-shots that are rhythmically 
compatible with your source sound. Selecting this option will compile a list of new 
sounds that we think will be worth your while. 

Find similar sounds 
Creates a new search tab with content similar to the selected sound. This is based on 
Loopcloud’s tagging system. It will look for sounds that match the instrument type in 
combination with the audio properties analysed in Audio Filters. In the new search the 
sounds will be ordered by similarity. This is displayed in the search results under the 
Similarity tab. 

Save searches 

If you find that you are running the same searches time and time again, it is possible to 
save a search so that you can quickly recall it.  

You can do this by clicking the search icon next to the search bar and selecting 
Save current search.  
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To recall a saved search, click the search icon again and select your search from the 
menu.   

 

Advanced: You can assign a keyboard shortcut to open this menu in the preferences 
(and then use the arrow keys and enter to select a search). Allowing you to quickly run 
your most used searches with only a couple of keystrokes. 

Sorting search results 

Search results can be sorted alphabetically, or by any of the columns in the search 
results. 

Click on the column title that you want to organise your results by. For example, you can 
organise your files by BPM.  

 

Click the column again if you would like to show a descending order. 

Add other columns by right clicking the column header bar and selecting which field 
you would like to show. 

Main 
Shows all the general information of the files such as file name and any other default 
tags. 

Tags 
Additional tag information such as genre. 

Audio attributes 
See the value of each audio attribute for the files in your search. This is great if you want 
to order your results without filtering anything out. For example, if you want to order 
your results from most to least swing percentage.  

Hide a file from future results 
Do you ever find yourself coming across a file again and again? Not the one you want, a 
sound you really dislike. Then you can hide the file from appearing in any further 
searches but right clicking and selecting View>Hide item.   

You can also hide whole folders and sample packs in the user library view.  

To show hidden items go to the preferences and enable Show hidden items. Here you 
can un-hide items. 
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Labels search 

The LABELS tab under the tag search provides a list of all the labels with products on 
Loopcloud (and potentially other labels whose content you’ve purchased from 
loopmasters.com).  

If you are on the Home or Library tabs and select one of the labels from this list, you will 
be directed to a new page showing all the products from the label. This is a great way to 
go through all the content from a label that you love. 

However, you can also use the label tags in a regular search. This way you can find 
specific sounds from a label. 

For example, you may want to find all the kick drums from Loopmasters. In this case you 
would: 

• Run a new Kick drum search by selecting the Kick tag in a new search tab 

• Select the Loopmasters tag from the Labels menu 
• The results produced will all be kick drums sounds that have been produced by 

Loopmasters. 

Tabs 

If you run a new search from the Library or Home tabs, the search will appear in a new 
tab. 

 

You can add new tabs using the + icon to run multiple different searches at once. 

Mac: ⌘ + Shift + T Windows: Ctrl + Shift + T 

Close tabs by clicking the X icon next to the tab name. 

Mac: ⌘ + W Windows: Ctrl + W 

If the number of tabs goes beyond the window size of the application, you can use the 
Show all tabs icon to go between tabs.  

Next tab: 

Mac: ⌘ + Shift + } Windows: Ctrl + Shift + } 

 

Previous tab: 

Mac: ⌘ + Shift + { Windows: Ctrl + Shift + { 

The icon next to this will hide/show the sidebar.  

Advanced search 

Advanced search features can be used if you have a very specific search in mind.  These 
are features are for IT-savvy users who are comfortable with boolean logic.  You don’t 
need to use them to understand Loopcloud but they can be very useful if you have a 
large library of sounds and want to adjust or improve the tagging.   
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Most advanced search features do not work with the store content.  Ensure store is 
disabled in the filter toolbar to avoid errors when using these features. 

Using Boolean to search 
Use AND, OR, NOT and brackets ‘( )’ to refine your search.  

These are particularly useful for removing results from a wide search. 

For example, you may want a Reggae sound that isn’t a drum – but the results show 
mostly drums. 

In this case use: 

Reggae AND NOT Drum 

This will remove any drum files from the search. 

Another example is to add a mixture of results. Let’s say you are looking for both a kick 
and a low tom. Instead of running two searches, run: 

kick OR (tom AND low) 

This will give results of both kick drums and low tom files. 

Search prefixes – using text box for tag searching 
This allows you to search and refine tag-based information using the text box.  

BPM Search 
Search by bpm using: 

bpm: (write your bpm range here e.g. 120-124) 

Tags 
Search for a Tag; for example: 

tag:House 

Tags with spaces need to be in quotes, including the tag: prefix.  

“tag:Drum Loops” 

Searching for a tag includes all the sub-tags in the hierarchy of tags.  So searching for 
tag:House includes all types of house music, and searching for 

NOT tag:Genre 

Will show all samples not tagged with any genre. Include Boolean in other areas of the 
search in order to extend your search. 

To only specify a specific tag, use exact tag. 

exacttag:House 

To only show items with the specific tag of house – removing any sub-tags.  

You can also search by UUID, if you happen to know the UUID of the tag you are looking 
for.  It looks something like this:  

tag:123e4567-e89b-12d3-a456-426655440000    
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The UUID may be useful if you end up with two tags with the same name.  The UUID 
does not change if you rename a tag, nor if Loopmasters rename a tag, so may be a 
good option when writing scripts that may be used some time in the future. 

You can find a full list of the tags by ALT + Right Click on a tag in the tag manager and 
selecting Copy uuid to clipboard. 

You can also find a complete list of UUID’s from Loopcloud in your Loopcloud folder 

Windows: 
C: \%AppData%\Roaming\Loopcloud\[your_user_name]\tags.cache 

Mac: 
[HardDrive]\Library\Loopcloud\[your_user_name]\tags.cache 

Folders 
Results will show all the files from folders matching the search criteria. Very useful to 
cleanly show all content from a folder. 

These are case insensitive:  

folder:drums 

Again, use quotes around the whole thing if the folder name contains spaces. 

“folder:drum loops” 

Regular expressions - power user tool 
Nerd friendly and powerful. They let you perform magic. 

For example, You can find all the files with WAV extensions that start with the word 
BASS and contain a number in the file name.  

If you can think of it, regular expressions can do it.   Regular expressions are also case 
sensitive, unlike our other kinds of search. 

regex:.*\d{1,3}_.* 

The regular expression format is documented here:  

http://www.cplusplus.com/reference/regex/ECMAScript/ 

Complete list of search commands 

COMMAND FUNCTIONALITY 

folder: Search foldername. 

tag: Search tag by name or UUID. 

exacttag: Search tag by name or UUID, do not include child tag matches. 

regex: Search filename using regular expression. 

bpm: Match a bpm or bpm range. 

http://www.cplusplus.com/reference/regex/ECMAScript/
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extension: Search by file extension. i.e. .wav or .midi 

favourites: Show only items marked as favourites – accepts yes or no. 

downloaded: Accepts yes or no, will filter results of downloaded files. 

online: Accepts yes or no, useful if you have imported files from external drives 
that are not available (they will be currently offline until the drive is 
plugged in). Use this to show/hide offline files. 

AND Use to add search terms together. 

OR Adds separate searches to the same results. 

NOT Removes terms from a search. 

() Search will read commands contained within parentheses as one. 
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Loopcloud store 

 

Loopcloud store allows you to search and purchase any sound from our library of 
millions of samples and thousands of packs. 

The store page will automatically open when you log into Loopcloud by default. 

You will be presented with a selection of products for you to browse.  

Click on the product image (or the i icon) to view the product 

Click on the play icon to listen to the demo track. 

Once you have clicked on the product, you will be taken to the product page where you 
can view the pack in full. 

Click on any file to listen to the preview.  

Low Quality Preview with Noise 
All files in the store have some additional noise (white noise mixed with some bird song). 
Once you've bought the sound all this noise is removed.  

Noise and bird sounds are removed from all preview sounds for 
paying subscribers. This will allow you to preview the high quality 
file. 

Buying a sound 
To purchase a sound, within the State column click on the quick purchase icon.  
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You can also select the BUY button from the editor window at the bottom of the app to 
make a purchase. Buy all the files in you have loaded in Loopcloud by clicking this 
button and selecting BUY ALL. Purchase just the currently selected sound with BUY 
ONE. 

 

Suggestions tab 

The Suggestions tab shows popular or relevant content on 
Loopcloud.  

Finding a previously selected file 

 

You're looking for the perfect percussion loop for your track, after some time you realise 
that your answer was found 3 minutes ago. 

Click on the History tab located in the side panel. 

Here, Loopcloud shows list of all the files that you have previously selected, as well as a 
timestamp of when you selected it.  

Click on any item in the search history and Loopcloud will display that file in the preview, 
on the currently selected track.  



 

24 
 

 This will only bring up the original audio file. Therefore, if you had made any edits to the 
audio previously, these will not appear. 

Loopcloud store - buying points 

You need points to buy samples; with a subscription you will receive a monthly 
allocation of points.  

If you run out of points you can upgrade your subscription or buy top up points. 

Click on the account icon to buy more points or edit your subscription settings 
(or visit loopcloud.com and log in). 
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Free samples 
Loopcloud will come with some free content already in your library to get started – in a 
folder called Sound Foundations. 

However, each subscription plan provides a number of free sample downloads per day.  

Locate free samples in a pack by clicking FREE in the pack’s banner. 

 

A quick way to show the free content when running a search is to select the FREE icon 
in the filter results bar. 
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Library view 

 

Access the library view by clicking the Library tab. 

Mac: ⌘ + Shift + L  Windows: Control + Shift + L 

In the library view you can: 

• See the files you own organised by folder structure. 
• Make changes to the tags or bpm for whole folders. 

Navigating the library 

All the packs you have bought from loopmasters.com and the Loopcloud store will 
appear in the user library. 

If you’ve never bought any content from us, we’ve given you some free content to get 
you started. 

In the user library itself you will find a list of folders that correspond to your files. 

Use your mouse or the arrow keys to navigate, open and close folders.  

You can also right-click a folder and choose Expand all or Collapse all. 
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Alongside each file will be some basic information:  

• A view of the matching waveform. 
• Relevant key information. 
• Whether the file has been added to your favourites. 
• The BPM of the file. 
• The disk size. 
• Indication of the state (whether the file has been downloaded etc.). 

If you would like to add further information to this list (e.g. the list of relevant tags), right 
click the bar that titles each column (above all the folders). Then choose the field that 
you would like to add. Click on titles with a tick next to them to remove from view. 

Top-tier folders display information from the files within that folder. If lit, then all files in 
that folder have the same information. If dim, then not all files have the same 
information. This applies to any tag-based information. 

 

Individual files will show additional information such as BPM, file size etc. 

All columns can be resized and reordered to suit your preference.  

Click and drag the column header to change position – i.e. if you would like to see the 
instrument tag ahead of anything else, then drag it next to the waveform column. Be 
aware that the NAME and WAVEFORM columns cannot be reordered but can be 
removed.  

Resize the column with click and drag on the right end of the column header.  

Use these techniques to customise your user library to show the information you need 
to see and fit the library window to your screen size. 

Filter library 

On the library tab there is a filter box.  If you like to browse your library by folder you can 
use this to find specific files, folders or packs.   It’s particularly useful for showing only 
packs that match a specific genre.  Clicking on tags in the library tab will automatically 
add them to the filter, or you can enter terms in this box manually using the keyboard.  It 
supports all the features available in the main search box.   

 

Adding your own files 

Samples you already own on your hard disk can be added to Loopcloud. 
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You can then enjoy the fast searching and other features of Loopcloud on all your 
content. Imported files will appear alongside your Loopmasters purchases making for 
easy searching and browsing. 

Points on importing your own files to Loopcloud 
• Add sample folder(s) by simply dragging into your library in Loopcloud. 
• Any changes made to files or folders outside of Loopcloud will automatically 

synchronise in the application. 
• Imported samples appear in Your Library in Loopcloud alongside all your 

Loopmasters purchased content. 
• Loopcloud will analyse your files upon importing to tag them. Meaning that you 

can search any files using tags. 
• Loopcloud will prioritise the folder that you have open in your library when 

analysing. This helps you work using the files you need quicker. Click on the 
folder you want to open it, and it’ll be analysed first. 

• It is also possible to add custom tags to curate your sample library. 

Importing Sample Folders 
There are three ways to add samples to Loopcloud... 

• Click on the Add Samples… button in the top right of the Loopcloud page. 
• Locate and select the folder you wish to add to Loopcloud and click Open. 

 

 

Or you can drag and drop any folder directly into Loopcloud. This will bring up a window 
confirming the import, select ok and the folder will be added to your library. 

 

Note:  
If you are dragging in files that are not already in a folder, it must be dragged to an 
existing user content folder in Loopcloud. Otherwise the file will not import. After 
dragging to the appropriate folder, confirm the import of the file. 
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You can also add samples by going to the menu icon in the top right hand of the 
application and selecting add samples. Then locate the folder which you would like to 
import. 

Importing using this method or with the Add Samples… 
button will only allow you to import complete folders. In order 
to import individual file, use the drag and drop method. If you 
choose to reimport the same folder again, Loopcloud will 
simply re-sync your existing folder. However, any changes to 
the folder will automatically appear in Loopcloud anyway. 

Each folder that you add will be referred to in this guide as a 'base folder'. All content 
and sub folders in the base folder will be added to Loopcloud. 

What you can add 
• One or as many base folders as you like. 
• Multiple folders at the same time. (i.e. you don't need to wait for the analysis to 

complete before adding a new folder). 
• Folders containing any files types, all accepted file types will display in Loopcloud, 

but only audio files will be analysed. Any file types not accepted (e.g. DAW 
analysis files) will not appear in the folder within Loopcloud. 

• Folders from any type of internal drive or external USB, Firewire, Network drive 
etc. 

• File analysis processes files that are up to 2 hours long.  

What you cannot add 
• A subfolder that is already contained within a base folder in Loopcloud. 
• A folder that contains a base folder that has already been added. 
• The Loopcloud Library folder (as defined in your preferences), or its base folder. 
• A folder that is stored on an external cloud provider (you may experience issues 

with other cloud services). 
• A 'link' or 'alias' to a folder.  
• Compressed folders. 

Indexing files 

 

Once a folder has been added, the contents will be counted and scanned. During this 
process, you will see the files and folders appear in the tree view. The status bar at the 
bottom of the UI shows a how many files have been scanned so far. 

If you accidentally added the wrong folder, then press the CANCEL button to abort the 
import process. 

Indexing is completed when all files have been added to the Loopcloud database. 
Loopcloud will now analyse all the files and generate tags. 
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File analysis 

 

The following tags will be generated on your files. 

• File format (.wav > wav, .mid > MIDI, etc) 
• Instrument type 
• Key 
• Content type (One shot / Loop) 
• BPM 
• Additional (Rhythmic information - e.g. 16th triplets) 

Loopcloud applies tags to your user content using the AI tagger. Which can accurately 
tag your sounds based on analysis of the audio file. So, the details do not need to be in 
the filename to generate tags.  

In addition to AI tagging, the analyser looks at the file name to generate tags. Together, 
the analyser can provide great analysis of your content. 

Auto-tagging can take some time to complete, depending on how many samples you 
add and the speed of your computer. If files are well named, then this process will be 
quicker. However, files that need to be analysed will take longer. 

The status bar at the bottom of the UI displays info on how many files are analysed and 
the total number of user content files. 

Fast mode 
This is the default mode.  It may use all your computers CPU.   

Low CPU mode 
Use this mode if you want Loopcloud to keep analysing in the background, while you 
use your computer for something else. Loopcloud will analyse more slowly and use less 
CPU. 

Pause 
Use this to temporarily stop analysis. Once deselected, the analysis will continue from 
where the pause was made. If you close the app with analysis paused, then Loopcloud 
will hold this position once the app is reopened. 

Cancelling analysis 
If you accidentally added the wrong folder, but the indexing process is already complete. 
Press the Pause button and right click on the folder in your library; select File > Remove 
from library and confirm. This will abort the analysis process and remove the folder from 
your own content.  

Manually analysing and editing user content 

Loopcloud auto-tagger does a good job of finding tags, but it may make the odd 
mistake! 
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If you want to re-analyse a file or folder then right click, find Loopcloud AI then select 
one of the following options (BPM, key or instrument). Select the option relevant to 
where there is a tagging mistake. This analysis will look specifically for that information. 

Loopcloud AI advanced 
Use the advanced features to get more specific with your re-analysis or clear tags from a 
file or folder. 

BPM 
Use this if your file has the wrong BPM (e.g. 2x or 1/2 speed): 

• Select the Auto BPM option with the range closest to your sample. 
• Set to one-shot if the file has been tagged loop, when it is in fact a one-shot. 
• Clear BPM and tags will remove the BPM and the One-shot / Loop tag. 

Key 
• Use Detect Key (Ignoring Filename) if the analyser is getting the wrong 

information from the filename (e.g. file with the name A_Synth_Pad in the key of 
G could be tagged in the key of A). 

• Clear key tags will remove any existing key tag. 

Instruments 
• Set instrument tags using filename will scan the file/folder searching for possible 

instruments tags. 
• Clear instrument tags will remove all tags related to the instrument. 

Tag Editor 
If you want to do more detailed tag editing, such as addition custom tags, you can do 
this with the tag editor. 

Browsing your own content 

Your own content folders are displayed in your library alongside all your Loopcloud 
content. 

'Loopcloud Local' (your own content) display a folder icon with filled blue colour. 

 

Content purchased from Loopmasters.com or from the Loopcloud Store is displayed 
with solid folder icons. 

 

Files showing a spinning wheel are in the queue for analysis and so will not yet have any 
tags. 
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If you have samples on removable disks that are not connected to the computer, 
Loopcloud will display the folder greyed out with a different folder icon. When you 
reconnect the disk, the folder will automatically become available once again. 

 

Filtering your own content using the filter library search bar 
There is a search bar within the library view which you can use to run searches that only 
apply to the library. These can be text searches or tag searches. 

Just type to start the search, it will bring up suggestions for tags. Select tags from the 
drop-down menu to add them to the search. Do this as opposed to using the tag 
selector that you would use in to run a store search. 

Renaming 

Base folders 
You can rename the base folder (the top-level folder of content you imported) so that it 
is easier to find in your library. 

Right-click on a base folder and select File > Rename in library. 

 

Give your folder a new name and press OK. 

Note: 
• Renaming the base folder in Loopcloud will not change the name of the folder on 

your disk. 
• If you rename the folder on the disk after changing the name in Loopcloud, the 

application will no longer be able to find the folder and an error will occur. Please 
ensure that you either change the name on or hard drive or in Loopcloud, do not 
attempt to do both. 

• You can only rename folders that are User Content, you will not be able to 
rename folders of Loopcloud Content. 

Subfolders 
You cannot rename subfolders in Loopcloud. This is because Loopcloud synchronises 
with changes made to folders on the hard disk. If you want to rename a folder you must 
do that in OSX Finder, or Windows Explorer. 
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Keeping Loopcloud in sync with folders and samples on your disk 

• Loopcloud will not make any changes to files and folders on your hard disk. 
• Changes to any files and folders made on your hard disk will automatically 

synchronise in Loopcloud. 

If any folders or files are added, removed, or renamed from the base folder on your disk, 
you will see these changes update in Loopcloud. 

If Loopcloud is closed when you make changes to your folders, then it will scan for 
changes when it restarts. 

Disabling automatic re-indexing 
If you rarely make changes to your samples on disk you can speed up the loading of 
Loopcloud by disabling Scan folders on startup in preferences.  

 

However, changes made while Loopcloud was closed will not update unless you 
manually re-index the folder(s). 

Right-click on the user content base folder and select File>Re-index this folder to 
manually re-index. 

Moving and removing 

You may want to remove a base folder, or you may want to move samples from one 
folder to another. 

With the case of moving files. If both folders are already synced to Loopcloud, then move 
the files in Windows Explorer or Mac Finder and the changes will be automatically 
updated.  

If you try to move the files between folders in Loopcloud (by dragging and dropping), a 
copy of these files will be made in the new folder.  

Also, if you move the sounds to a new folder that has not been added to Loopcloud – the 
files will disappear from the application. Simply drag and drop the new folder into your 
library to recover them. File tags for files previously analysed will be restored without the 
need to re-analyse. 

The same is true for if you were to manually remove a folder. 

You can do this by right clicking on the base folder and select File > Remove from Library 
and confirming. 

Loopcloud makes a backup of all the tags for the content that is to be removed. 

Re-adding a folder 
Drag and drop the folder back into Loopcloud. The folder will be re-indexed, and all files 
that had previously been tagged will be restored without re-analysis. 
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User content images 

Loopcloud shows images for content purchased from Loopmasters or within Loopcloud.  
You can set images for content you have added too. 

For each sample Loopcloud displays any .jpg or .png image found in the same folder or 
any of its parents.  Images called loopcloud.png or loopcloud.jpg override images of any 
other name.   

If there is no image in a folder or any parent folder, the default image from the 
preferences page will be used. 

Note:  
Images should be square, and 400x400 pixels is the ideal resolution. 

You can also set and remove images by hovering over the artwork in the preview editor 
and change selecting SET IMAGE or REMOVE.  

Cloud Storage 

 

Subscription users have access to Cloud Storage where files can be stored across 
systems. A new version of the file will be saved within the cloud. 

Your cloud storage will appear at the top of the library view, as a folder called Cloud 
Storage. You can also see how much space you have left (in Gb and as a percentage).  

The cloud storage folder operates like any other folder in the tree view; however, you can 
access files contained within this folder from any machine you log in to. 

Adding files to cloud storage 
After you import new files into Loopcloud and they have been analysed, then you will 
automatically be prompted to add the new files to cloud storage. Accepting this is one 
way to add samples to your storage.  

 

You can also drag and drop sound directly into the cloud storage folder. 

Right click a file or folder and select File > Add to Cloud Storage. A new window will pop 
up and allowing you to direct the selected files to a specific folder in Cloud Storage. 

Managing the Cloud Storage folder 
Inside the folder itself is a little different to the other folders in the library view. The files 
are stored independently on our network. This means that the file data for Cloud Storage 
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is not stored on your system – unlike with the files in your library. Therefore, the files 
added to Cloud Storage are not impacted by changes made on the disk. So, you can 
create independent data for these files. 

Right clicking in the Cloud Storage folder will provide a set of actions that allow you to 
edit and manage files and folders. For example, creating new folders and editing tags. 
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Favourites 
While browsing sounds you may find something awesome that you want to save for 
later.  

Just click on the empty heart icon in the file browser or right-click on the file or folder 
and select File > Add to favourites. 

Shortcut: Alt + B  

The heart will go solid to show it’s been added. 

 

Any file that you have added to your favourites will show in searches with a solid heart 
icon. Adjust searches to show favourited files at the top of the search. Or, filter out every 
file except those favourited by using the favourite icon in the filter results bar. 

You can show a list of all your favourites by going to the menu in the top right of the app 
and selecting Show all favourites from the drop-down. 

 

Favourites sidebar 
You can also view a list of all your favourites in the 
sidebar. Select the heart icon in the sidebar menu, this 
will show a list of all your favourites. This allows you to 
easily access your favourite sound while making 
another search.  

Export a sound directly from the sidebar by clicking and 
dragging the sound into your project. 

Remove from favourites 
Click the X on a sound in the favourites sidebar to 
remove it from the list.  

Shortcut: Shift + Alt + B 
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The loop editor 
When a file is selected, it will load in the loop editor.  It can then be previewed, 
downloaded, and exported.  

You can also make edits and add effects to suit your needs.  Once you have edits that 
you like, try other files with the same edits as these will not change when a new file is 
selected. 

Things you can do with the editor include: 

• Shortening sounds and apply fades. 
• Turn one-shots into loops. For example, by putting a snare drum on beats 2 and 

4, better allowing you to hear how the sounds you are previewing will work with 
you track.  

 

Exporter 

Here you can buy, download or export the file loaded into the editor (or all the files on all 
the loop editor tracks).  

For files you own and have already downloaded you can export the file either as raw 
audio or including the processing made in the loop editor (for more information see the 
‘Downloading AND Exporting Files’ section). 

BPM 

 

This is the BPM (beats per minute) your loop will play at.  

Sounds with a BPM value, i.e. loops, will be time-stretched if their BPM is different from 
the value in this box.   

Change the BPM by clicking and dragging or double clicking and typing in a number.  
However, if you are connected to the Loopcloud plugin in your DAW, then the BPM 
value is automatically locked to your DAW tempo. 

Press x2 or /2 to quickly double or half the playback speed. 

You can also right click the number box and select Lock BPM and all files selected will 
play at that tempo. If not selected, the BPM value will change to that tagged on the 
selected sound (if you only have one sound loaded in the preview editor). 
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When using multitrack, you will not be able to change the BPM of each individual file. 
Also, the BPM will also not change when a new file is loaded, unless the BPM is manually 
adjusted. The only way you can independently adjust a BPM in multitrack mode is by 
using the x2 and /2 options. 

Pitch 

 

If the file has melodic content, Loopcloud will tag a key signature.  

Use the Pitch section to adjust the pitch of the file or change the key signature to match 
your track. 

With the KEY LOCK button selected it is possible to use the drop-down menu directly 
below to automatically adjust the pitch to a desired key.  

For example, if I have a file in the key of A but my track is in the key of C, then I can 
choose C from the menu and the file will re-pitch to C. 

With auto pitch selected, key adjustments will carry over when a new file is selected. 

The pitch slider can adjust + or – 12 semitones. Use the OCT button to quickly change a 
full octave (first click will go up; second will go down and third will revert to the original 
pitch).  

Loops may sound best when they are not transposed too many semi-tones.  Transposing 
a loop by 6 semitones will make acoustic instruments and vocals sound unnatural. 

Auto-pattern mode 

 

At start-up the editor is in auto-pattern mode.  In auto mode the loop length will adjust 
to suit the selected audio.  Short one-shots will repeat every beat, and longer sounds will 
be fitted to the loop length.  

Loops are fitted using their BPM. If the loop isn’t correctly stretched, make sure that it 
has the right bpm set in the Properties sidebar. 

If you make any edits to the loop, including changing the loop length, the editor will exit 
auto-pattern mode.  This means you can select alternative samples and hear them with 
the same edits applied.  This is useful for finding the perfect sound for your record.  

The RESET button light will illuminate to indicate that you are no longer in auto-pattern 
mode.  Press RESET to lose your edits and return to the auto-pattern mode.  

Mac Shortcut: ⌘ + R Windows: Ctrl + R 
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Saving and loading patterns 

Once you have some edits you like you can save those as a pattern and apply them to 
other sounds in the future.  Loopcloud pattern presets. 

We find saving patterns is most useful for patterns that turn one-shots into loops.  

You can scroll through the existing patterns using the arrow buttons, select one at 
random with the shuffle button, or click on the drop-down menu (which shows AUTO at 
start=up) to select a specific pattern. 

Save a preset 
If you have made your own pattern, you can save it as a preset by going to the pattern 
menu and selecting Save pattern…. 

Mac Shortcut: ⌘ + S  Windows: Ctrl + S 

These will appear in the Patterns menu under User presets. 

All user presets are stored in the following location: 

Windows 
C:\Users\username\AppData\Roaming\Loopcloud\loop_editor_sequences 

Mac 
[HardDrive]\Library\Loopcloud\loop_editor_sequences 

Go to this folder to organise your presets. Any folders made in this directory will 
automatically be nested in the Pattern menu. 

To delete a preset, delete the matching file from the directory and it will no longer 
appear in Loopcloud. 

Edit 

 

This section provides access to some of the other functions in the Preview Editor, as well 
as some primary edit functions. 

Undo/Redo 
The arrow icon’s in this section can be used to undo and redo actions – these can also be 
selected from the menu. 

Undo      

Mac: ⌘ + Z    Windows: Ctrl + Z  

Redo 

Mac: ⌘ + Shift + Z  Windows: Ctrl + Shift + Z 

Load/Save Session 
In the menu itself there are a variety of options, directly below undo/redo are the load 
and save session options. These are used to save and recall a complete session. 
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Load 

Mac: ⌘ + Shift + O   Windows: Ctrl + Shift + O 

Save 

Mac: ⌘ + Shift + S  Windows: Ctrl + Shift + S 

Using this will allow you to save a loop editor session including the audio file(s) used as 
well as any edits or effects added. Also recalling every track used in the session. So, if you 
have used more than one track you can recall all of them at once. 

Edit 
This sub-menu contains the basic editing functions within the Preview Editor (It is 
possible to access this menu in the waveform editor by right clicking) 

• Cut – remove selected region in the waveform editor and add to clipboard. 

Mac: ⌘ + X  Windows: Ctrl + X 

• Copy – add the selected region to the clipboard. 

Mac: ⌘ + C  Windows: Ctrl + C 

• Paste – add the clipboard region to the currently selected location. 

Mac: ⌘ + V  Windows: Ctrl + V 

• Erase – remove the currently selected region. 

Shortcut: Backspace 

• Duplicate regions – and a copy of the selected region directly after. If you hold 
while clicking and dragging on a region – you can make a duplicate and move to 
your choosing 

Mac: ⌘ + D  Windows: Ctrl + D 

• Clear track – reset all features on current track to default. 
• Clear all tracks – completely reset the loop editor to default settings. 

View 
This allows to you adjust the zoom of the waveform editor. 

Tools 
Manually select the editing tools available. 

Grid 

 

Change the size of the grid lines in the waveform editor. 
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The default is AUTO, this will adjust the grid size depending on the zoom. The current 
grid size is displayed over the waveform in the top right. 

Uncheck Snap to grid lines to allow you to move regions and make edits that don’t snap 
to the set grid.  You can hold down shift when using any tool to temporarily disable the 
grid. 

Tools 

 

Each tool will change the role of your cursor in the waveform editor. The descriptions 
below go chronologically to the icons in the tools bar (as above). 

Drag tool  

 

Shortcut: alt + 1  

This is the default tool. With it you can carry out many of the editing functions. 

The waveform editor is split horizontally in half. The top half will allow you to move 
regions. While, the lower half can allow to make selections to delete or cut/copy.  

It is also possible to drag out the edges of a region to lengthen or shorten. Or, in the top 
corner of the region, drag a fade out or fade in. 

You can adjust the volume of a region by dragging on the decibel value in the centre at 
the top of the region (as the default is at 0.0dB). If your file it still quiet at 0.0dB then 
drag up to increase the gain beyond 0.0dB. 

Holding down alt will give you quick access to the split tool. 

Holding Ctrl/⌘ then clicking and dragging a region will duplicate the region to the 
point where you drop it. 

Holding down Shift will allow you to select multiple regions. You can perform global 
changes e.g. move as a group or adjust the volume. All changes are shared between the 
items selected. 

Split tool 
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Allows you to make cuts in regions. Access this with the Drag tool selected by holding 
alt. 

Shortcut: alt + 2 

Slip tool 

 

Change which part of the file is playing in that region. This is particularly useful when 
working with long files, making it easy to chop up sequences. 

When you click a region with the slip tool, a small window will appear above your cursor 
to help you in finding the right position. 

Shortcut: alt + 3  

Mute tool  

 

Mute individual regions.  

It is also possible to mute with the Drag tool by double clicking on the region. 

Shortcut: alt + 4 

Reverse tool 

 

When you click on a region with this tool, the audio file will be reversed. 

Shortcut: alt + 5 

Pitch tool 

 

This will show a line on each region when selected. Click and drag on each to adjust the 
individual pitch of the audio. 
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Shortcut: alt + 6 

Pencil tool 

 

Click anywhere in the waveform editor with this tool to create a new region. 

Shortcut: alt + 7 

FX Edit 
This will open the Effect dock. If you have applied FX this button will illuminate. Once the 
Effect dock is open then the waveform will show automation for the FX. 

Zoom 

 

Control the zoom adjustment to the waveform editor. 

In the waveform editor, click and drag the timeline bar at the top to change the zoom 
size more precisely (you can also hold ctrl/⌘ and scroll). 

• Zoom all – This will revert the zoom to fully out. 
• Zoom in – incrementally zooms the transport towards the start. 
• Zoom out – incrementally zoom’s out the transport. 
• Waveform view – Gives an overview of the whole transport. Zoom using click and 

drag. 

DAW Link 

When an instance of the Loopcloud plugin is selected in your DAW, you can connect to 
it with this button. This will indicate that the app has successfully connected to the 
plugin. Click the power button to disconnect from the DAW at any time without 
removing the plugin from the project. See more information in Using Loopcloud with 
your DAW. 

Artwork and Transport Controls 
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Here will display the artwork – from relevant pack or personalised in your user content – 
as well as some master functions. 

Click on the i when hovering over the artwork to show the full pack – you will only be 
able to do this with store content. 

• Play/Pause spacebar – global buttons for starting and stopping the transport. 
• Solo – the s icon will solo the currently selected track (muting all other tracks). 
• Loop – makes the loop bounds to be active, or not. 
• Volume knob – set the volume of the currently selected track. 

Tip:  
When running a search, you can load a shortlist of results on different tracks, then use 
solo to quickly audition each and find out which you like best. 

Waveform Editor 

 

Here is where your file will appear once selected. This is also where you will make any 
edits your file. Be aware that any changes made in the waveform editor will carry over to 
the next selected file. To reset the track, use the edit menu. Or, right click and clear track 
in the Multitrack Bar. 

Multitrack Bar 

 

The bar at the bottom of the Preview Editor allows you to select between different 
tracks.  

The number of tracks that are available depend on your 
subscription level - free subscribers will be limited to 2 tracks 
while paid subscriptions have 8.  

In the bar itself you can easily mix tracks by using the gain slider to the left of each track. 
There is also a m icon, when hovering on the far right of a track, which will mute the 
track.  

 

Right click on a track to make a clearance to the file. Reset to auto pattern will remove 
any pattern from the track. Clear track will reset the selected track. Clear all tracks will 
reset the complete multitrack session. Show in library will open your library at the 
location of the selected file. 
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Effects dock 

 

Open the effect dock using the FX Edit button in the Preview Editor. 

Effects can be applied to the whole loop or just regions of it.  

For Example: 
A hi-hat pattern may require reverb which can be applied to the whole loop but using 
the panner on individual regions can place each hit at a different position. That way you 
can easily make a stereo moving hi-hat rhythm. 

In the effect dock you can add effects from Loopcloud native FX: 

• Compressor – Easy to use compressor to beef up your sounds. Use Speed and 
Amount to change the impact the compressor has. Presence will add clarity and 
punch to the mids. 

 
• Delay – Simple stereo or ping-pong delay with synced or free tempo. As well as 

filtering for the wet signal. 

 
• EQ – Adjust the tone balance of your sound to fine detail with this four-band 

parametric equalizer. Make changes by clicking and dragging any of the four 
nodes. Fine tune the frequency, gain and Q point of each band in the left-hand 
panel. You can also change the curve type of each band here. 

 
• Filter – High-pass, band-pass or low-pass filter with big knob cut-off frequency. 

Resonance will add focus to the cut-off frequency and drive will add some gain to 
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the signal. 

 
• GrainStretch – This is a great too for creative sound design, particularly for 

making metallic and glitchy effects. The Stretch parameter will impact how much 
time stretch will be applied to the audio file – a greater value here will produce a 
more noticeable effect. Grain Freq will impact how long each grain is – a lower 
frequency will preserve more of the natural sound, while a higher frequency will 
further warp the sound. Soft/Hard impacts the size of the fade between grains 
therefore, in Hard mode, transients are better preserved. 

 
• Panner – One knob L/R panner. 

 
• Reverb – Digital reverb scalable by size. Mix how much reverb you would like to 

hear and use the tone adjustment to focus on specific frequencies. 
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• Stop Reverse – This will add a vinyl stop effect and then reverse the audio slowly 
back up to speed. You can adjust where this will take effect with automation. 

 
• Tonebox – is a distortion and cabinet effects unit Select from six distortion types 

and 18 cabinets. Use the Drive and Tone knobs to control the amount of 
distortion applied. Low settings will give slight tone adjustment while higher 
settings will produce some audio mangling. 

 
• Vinyl stop – This will just add a vinyl stop effect to the region. The speed of the 

stop is adjusted using the knob in the effect.  

 

Adding an effect 
Press the + on the centre of the FX panel, this will bring up a menu listing the Loopcloud 
native FX. Each has a list of presets. The presets are particularly of use to ‘free’ 
subscribers because they will not be able to edit the effect parameters or automation.  

With a free subscription if you try to click in the Effect dock (aside 
from the add icon), a window will prevent usage. This can direct 
you to a page where you’ll be able to adjust your subscription 
plan. 

Once you have added an effect feel free to add as many as you like. If your signal chain 
goes beyond the view of the FX Dock, click and drag the bar directly below to side scroll. 

Automation 
With any paid subscription, FX editing is allowed. This means that 
you can adjust the FX parameters to suit you.  

You will notice that the waveform is overlaid with new parameters with the Effect Dock 
open. This is the automation for the effect. Adjust this to choose which regions you 
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would like to be affected. You can do this with the drag tool functions. Close the FX Dock 
to hide the automation. 

 

To change between effect automation, select the effect you would like to automate in 
the FX dock.  

The current effect automation is detailed in the watermark at the centre of the 
waveform. 

Adjust automation in the Waveform Editor. In the top left of the region, there is a menu 
where you can select different parameters.  

 

On the top right of the waveform, you will be able to the change the automation LFO. 
There are a variety of shapes available that will change the automation curve. This will 
default on SWEEP, unless using a preset that uses a different shape.  

 

Drag the node on either side to control the amount of movement in automation.  

Click the line anywhere between the two nodes to move the line as one shape.  

With any other shape, other than SWEEP, the number of times that a shape repeats over 
the time can be adjusted using the second node. 

 

This is bound by Snap to grid, you can remove this setting in the Grid section. 

With multiple regions in your Waveform Editor view, each region has the option to 
control unique automation. This is great for getting creative.  
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If you would like the same automation to appear across all regions, then press the link 
icon (next to the shape menu). This will only apply to the currently selected parameter.  

Turning off the link button will not revert to the previously set automation.  

 

Effect presets 
When loading a plugin, a menu will extend on each effect with a selection of plugin 
presets. Click on one of the presets to load the plugin with the preset. 

Easily browse presets with the plugin loaded by clicking the arrow keys at the top of the 
plugin. 

Alternatively, select the menu icon to find a specific preset. 

Save presets 
Save your own preset by clicking on the plugin menu icon and select Save preset… 

Then enter a name in the window that pops up. 

Find your preset under User presets in the plugin menu. 
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Using Loopcloud with your DAW 
Installed with Loopcloud is the Loopcloud Plugin. This will improve your workflow and 
offers great ways to preview sounds in context with your track. 

Open your DAW and load the Loopcloud plug-in onto an instrument track. 

Once the plugin is loaded in your DAW, return to Loopcloud and click the Connect to 
DAW button in the lower right corner of the window.  

Loopcloud is now connected and in sync your DAW. When you start the transport in 
your DAW, Loopcloud will automatically play your preview in time with the DAW tempo.  

Tips: 
• Most DAWs have an auto-load or a template project. Add Loopcloud to a channel in 

this template, so every time you open a new project Loopcloud is ready waiting for 
you. 

• You can use the Loopcloud plugin as a simple ‘in-sync’ sample preview. You can also 
use it like any other plugin. Therefore, use it as part of your signal chain (i.e. add 
effects after). This way you can hear your previews in context with the rest of your 
track. 

Connect multiple instances of the Loopcloud plugin 
You can now connect the Loopcloud plugin multiple times within your project. So, you 
can demo different ideas on different tracks.  

In your DAW, open two instances of the Loopcloud plugin on different tracks.  

Open Loopcloud and click the Connect to DAW icon in the bottom right. This will open a 
drop-down menu where you can select the instance you want to run Loopcloud to. 

The selected instance will become active in your DAW while any other instances will 
remain unusable. 

 

Click the DAW link icon again to remove the connection and repeat to select a different 
plugin. 

Using the plugin with MIDI 

If you load the Loopcloud plugin onto an instrument track in your DAW, you will be able 
to use MIDI to play and arrange parts.  
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Add MIDI notes to the DAW transport to play your sample at different pitches. For 
example, if you have a synth pad sample you may want to play some chords as opposed 
to just the set pitch.  

Be aware that the MIDI note C3 is the root note so, when using this feature, be sure to 
set the AUTO pitch to C. That way the file’s pitch will match the notes on the keyboard. 

Once you have made a part which you are happy with you can either record the channel 
individually to create a complete audio file. Or, save your session in Loopcloud and 
reload the session the next time you’re working on the track. 

Loopcloud Drum & Loopcloud Play 

Loopcloud Play and Loopcloud Drum are additional plugins bundled with the download 
of Loopcloud. They provide access to a host of new sounds from your favourite 
producers. Loopcloud Play is a synth player meanwhile Loopcloud Drum is a drum 
player. When you open up either plugin in your DAW, Loopcloud will automatically 
open. On the first load of either plugin, the native presets will download in Loopcloud. 
This way you have sounds to play with immediately. Loopcloud must be open in order to 
load any preset. When you download a new patch from Loopcloud you can drag and 
drop from the FILE icon straight into the plugin. This will load the new preset. 
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Downloading and exporting files 
Loopcloud streams audio in a preview quality version, this compressed file is much 
smaller than the high-quality version, so it is quick to stream to your PC.  

When you want to hear the full quality version and export it, then you need to download 
the file to your computer. Click on the export button to download the file to your 
computer.  

The file will automatically download if it is not already on your system. You will not be 
able to export the file until the download has finished. 

The Export Button 

Loopcloud 6 brings a new way to export your sounds to make the process quicker and 
easier with all functions contained within one button. 

The quickest way to download your file is to drag from the export button, or click it to 
copy the file to your clipboard. Then bring it into your project. 

You can also download multiple files at once. Select all the files that you want to 
download, right click and select Download in background. 

Mac: ⌘ + shift + D  Windows: Ctrl + shift + D 

On the button itself, you can see which export type is has been selected. Change the file 
you want to export by opening the Export Preferences (the cog icon to the right of the 
export button). 

Export Preferences 

Export 
The export drop down will allow you to change what is exported when using the export 
button. The options are as follows: 

Current Mix 
Produces an audio file that complies all the tracks in your Loopcloud session into one. 
The file will match the longest file in the session, with any smaller tracks being looped to 
fit. This will give you an audio file that is a complete loop. 

This method exports after edits and FX applied to the audio files. So, any changes to the 
audio files in Loopcloud will appear on the exported file. 

Original File 
Export the raw file of the currently selected track only, without any edits made within 
Loopcloud (such as BPM and pitch changes). 

It is also possible to drag the file from the results view to export the raw file. 
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Processed Current Track 
Will export the version of the file on the current track, containing any edits made within 
Loopcloud. For example, if you have created a pattern out of a file on Track 1 and added 
FX then this method will export the audio from Track 1.  

Processed Separate Files 
Exporting this way will produce a similar result to Processed Current Track, however it 
will export all the tracks in your Loopcloud session as individual files.  

The sizes of each file will match the length of a single loop of each sound. As opposed to 
being repeated to match the longest loop. 

Original Separate Files 
All the files in your session will be exported as individual files but any processing from 
your Loopcloud session will be removed. Note that this does not only remove effects but 
also BPM and pitch adjustments. 

Note:  
• If you are exporting files that are not audio files (e.g. MIDI), then you can only export 

this file on its own. It will not be included in any group exports. Instead, the track will 
only allow you to export the original file. 

• Once downloaded, files are saved to the Loopcloud folder on your hard drive. If you 
would like to see this location, then right-click a downloaded file and select Show in 
Finder (OSX) or Show in Explorer (Windows). Or, find the download folder location in 
your preferences. 

• Once downloaded, files are saved to the Loopcloud folder on your hard drive. If you 
would like to see this location, then right-click a downloaded file and select Show in 
Finder (OSX) or Show in Explorer (Windows). Or, find the download folder location in 
your preferences. 

• You cannot export folders from Loopcloud. 
• Clicking the Export button will copy the file(s) to your clipboard. You can then paste 

to a location of your choice (some DAW’s such as Reaper, Studio One and Bitwig do 
not support pasting files from clipboard meaning – this feature is not available in 
these DAW’s) 

Mac Shortcut: ⌘ + V  Windows: Ctrl + V 

Exporting regions 
Export regions of your edited file from within the loop editor by dragging out the region 
to your DAW or folder of choice. This allows you to quickly export edited files. 

Dragging hides Loopcloud 
With this enabled, the Loopcloud window will temporarily minimize which dragging the 
file into your DAW. This makes it easier to find the right place for your exported file. 
Disable this in the Export Preferences. 

Export a file to a location 
It is now much easier to export your files to a specific location on disk.  

With a file or session loaded that you want to export, press ctrl/⌘+E. Alternatively, you 
can select EXPORT TO LOCATION in the Export Preferences. 

This will open a new window where you can select the location to save your file. 

Change the default export location 
Open the Export Preferences menu.  
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Expand the Advanced Options menu. 

Here you can set a custom folder. For example, your personal sample folder on disk. 
Then every time you use the export to location shortcut, the explorer will automatically 
open to this file location. 

Ensure that Use custom folder is enabled to use this feature.  

You can also enable Normalize, this will give all your exported files a matching output 
gain. 
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Tagging – File Information 
Files in Loopcloud can have tags applied.  The tags make it easy to find the files you 
want.  Sounds from Loopmasters have already been tagged. 

Your own content will be automatically tagged in import.  

You can add or remove tags to any file in Loopcloud.  You can do this to correct tags that 
are wrong or to add your own custom tags.  

Some are details that give information about the file, while other tags provide 
descriptive terms to aid searching – additions or edits are made in the Tag Editor.  

 

Name  
This is the full file name – the format will appear at the end in in light grey text (in this 
case the file is a .wav). 

Favourite  
Click the heart icon to favourite the file so it appears in your favourites list. Full hearts 
have been added to Favourites, empty hearts have not. Use favourites to keep track of 
sounds you use regularly or files you want to keep in mind for a future purchase. 

State 
State shows one of three icons. Above, the first (cloud icon) indicates the file is available 
in your library but is not downloaded to your disk. The Second (cloud over the monitor 
screen) means that the file is in your library and downloaded to disk – therefore is 
available to export. The third displays for store items that have not been purchased, the 
number in the box represents the cost of the file in points. If the file is free this button 
will show FREE. Click this button to make a quick purchase of the file. This will 
automatically load the file to your library.  

BPM  
Shows the BPM. Only Loops should have a BPM. The BPM value is used to accurately 
time-stretch the file to match your DAW tempo. Files with no BPM will not time-stretch. 

Key 
Shows the key or root note, and whether in a major or minor key. Auto-key will make 
pitch adjustments from this key. For example, if your sample is tagged as B, and you set 
the auto key to C, then Loopcloud will move the pitch up by 1 semitone. If your sample 
sounds out of tune then it might be worth checking that it is tagged with the right key. 

Tags 

Tags organised into the following categories:  

• Instruments 

• Formats (e.g. WAV or RX2, Sampler Patch or MIDI file) 

• Genres  

• Labels  
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• Additional  

Editing tags 

 

You can use the Properties tab to make any edits or additions to the tagging information 
of the currently selected file.  

For example, if you have a file that continues to be tagged as loops when the audio file is 
a one-shot (even after re-analysis). Then you can change the tag manually by removing 
the loops tag in the CURRENT TAGS section – the x icon next to the chosen tag.  

Then, add a one-shot tag using the text box (or by locating the tag you require in the 
TAG MANAGER section). 

 

Edit BPM and Key 
EDIT BPM and KEY sections allow for adjustments to be made to the BPM tag or the 
registered key. 

 

Adding a tag to a file 
You can easily add a tag to a sound in the Properties tab and searching for the tag you 
want to add. This will apply the tag to the currently selected sound. You can add create 
new tags in the TAG MANAGER section. 
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Removing a tag from a file 
In the Properties tab you will also see a complete list of all the tags that are applied to 
that file. Here you can remove any tags from the file by pressing the x next to the tag 
you would like to remove. 

Editing more than one file at once 
You can also select multiple files at once. Each time a new file is selected – and they have 
tags that don’t match the other files selected, any new tags will appear, unlit. Adding 
and removing tags with multiple files selected will apply the changes across all files. 

Creating a new custom tag 
Creating your own user tags has several interesting uses. For example, you may want to 
add more details to the existing tagging – i.e. you’ve got some guitar samples but want 
to tag some as CLEAN and some as DISTORTED. 

To create your own tag: 
• Locate the TAG MANAGER section of the properties view. 

 
• Right click on your chosen parent tag and select Create tag…, you can only add tags 

to the existing parents therefore you should choose one that is appropriate. For 
example, I want to add rhythmic timing information so I will create a new tag under 
Additional. 

• Choose a colour for your tag and press SAVE. The tag will show as your chosen colour 
in the results view. 

• Now I can SET that tag to add it to the file or find it in the tag search bar.  
• You can make any tag a parent by following the first three steps again. In my case, I 

might want to make some different time signature information under my Timing 
tag. 

• If you add the tag to the wrong place, you can drag and drop it to a new folder. Also 
edit one of your tags by right clicking and selecting Edit…. 

• Factory tags cannot be edited or dragged.  

Other uses for custom tags include: 
• Creating a tag for a specific track you are working on, that way you can add the 

tag to any file that you feel would suit that track during your search. This way you 
can simply go to the tag results when you’re looking for a sound to add. 

• If you are working with other artists or session musicians create a custom tag 
with their name on it to group all the sounds that are for that session.  

• If you find a file that you like, but you don’t need at the moment of the search, 
you can add a custom tag to group files that you want to use in the future. 
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Menu – Account and Preferences 
In the top right of the app there is a menu and an account icon. 

Account Window 

The account icon shows a rounded number of points that you have in your account. If 
you click on this, you will be taken to your account window. You can also get here 
through the menu and clicking Account. 

• Email – this indicates which account you are currently logged into. At the end of 
this row you can logout of your account. 

• Storage – Shows if you have cloud storage with your account. The total amount 
that you have as well as the amount used, will appear. 

• Points – This is the exact number of points in your account. 
• Subscription – The subscription level of your account. 

BUY MORE POINTS and INCREASE STORAGE will take you to the relevant links on 
loopcloud.com.  

SETTINGS will take you to a web page where you can adjust your email or password etc. 

Menu 

Show all favourites – Opens a new search that contains all the files that you have in your 
favourites. 

Check for updates – Will see if the version you are on is the most up to date version. 
Loopcloud does do this automatically but you can use this to manually check. 

Help – Takes you to a new webpage with a series of tutorial videos to give you a hand. 
Great if you’re just starting out. 

Account – Opens the account window. 

Preferences – Opens the preferences window. 

More – Lists some manual actions for shortcuts such as open user library. 

Preferences Window 

Open the preferences window by selecting Preferences in the Menu 

Mac: ⌘ + ,  Windows: Ctrl + , 

The window will have four tabs at the top. 

Options 
USER CONTENT 

• Analysis speed – Set’s the default speed for analysing imported content. Adjust to 
suit how much load on your CPU and RAM you would like to take. 

• Scan folders on startup – If enabled, the app will scan changes made in your user 
content folders while the app was closed. Uncheck if you are experiencing long 
startup times. 

• Select default image – Upload an image file. This will show for all files in your user 
content. Unless, a different image is set. 
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• Audio Attributes Feature – enables or disables the use of audio filters for 
searching. 

GENERAL 
• Auto-download small purchases – With this enabled any purchase you make, 

that is below a certain duration, will automatically be downloaded to your library. 
Disable this if you are finding the app to run slow when purchasing files. 

• Show hidden items – If you have hidden items previously and would like to 
retrieve them, then enable this option. 

• Show warning before exiting – when enabled, Loopcloud will show a pop-up 
message when closing the app to confirm the decision. 

• Select library folder – this will automatically be set to the folder created when 
downloading Loopcloud. It contains all the content that you download using 
Loopcloud. Change this location if you want to set a custom folder. 

VIEW 
• Colour scheme – Select one of our predesigned colour schemes. We have a light, 

neutral dark and dark mode available. 
• Multicolour waveforms – When in dark mode, it is possible to change the colour 

of the waveforms based on the setting here. 
• Always on top – If enabled then Loopcloud will always be in the foreground of 

your computer screen. 
• Scrollbar style – Changes the view of the scrollbar icon when searching through 

results. There are two styles, macOs and Hybrid. 
• Docks to screen edges – Will allow you to drag the window to the edge of the 

screen to change its resolution and dock to the chosen side. 
• Percentage screen width when docked to an edge – Will adjust the resolution 

size when docked. 
• UI zoom – This number will change the size of the UI (font sizes, icon sizes, etc.) 
• On startup show – choose which screen Loopcloud will automatically load when 

it starts up. Choose either Home screen or Library. 

ADVANCED 
• Enable debug logging – Debug logging will help Loopmasters solve user 

problems. Having it enabled may cause a slowed performance. 
• Database backups – Creates a backup on your downloaded content to prevent 

risk of file loss. Disable this feature to reduce disk space. 
• Do not close audio device – The audio device will automatically be turned off after 

inactivity, in order to save CPU. If you are experiencing audio device issues, then 
try enabling this feature. 

Install Directories for Synth Patches 
When downloading synth patches for external VST’s (i.e. Massive) you must ensure they 
export to the right folder. You can also change the folder if you would like to set a 
custom one. 

Audio 
Here you will find your audio routing settings. You can adjust your audio output to 
match a selected audio interface as well as adjust sample rate and buffer size. 

Keyboard Shortcuts – Finding and Creating 
Here you will find a list of all the keyboard shortcuts that are available in Loopcloud. If 
you would ever like to find out what the shortcut is for an action, use this as your point of 
reference. 
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You will also notice that many actions do not have attached keyboard shortcuts. This is 
to allow you to make custom shortcuts to your needs. If you find an action you regularly 
use does not have a shortcut then go ahead and add one here.  

Find the action from the list and select the plus button at the end of the row.  

Then press the key combination you would like to use as a shortcut. 

If the combination is already used by another shortcut then you will receive a warning 
about replacing it. Select OK and Re-assign if are happy to replace the key command. 
This will remove the command from the previous shortcut and apply it to the newly 
selected one. Otherwise press Cancel and chose another key command.  

You can replace existing key commands with new ones by using the same process. 

At the bottom of the tab is a reset to defaults button which will return all shortcuts to 
their original key command. As well as removing key commands you have added to 
make new shortcuts. 
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Advanced user features 
Advanced and debugging features can be accessed by holding down alt whilst 
selecting clicking on specific areas of the app.. These include: 

The main menu will show a sub-menu for advanced features: 

Bulk Tagger 
The bulk tagger allows you to repeat a list of searches and apply tags automatically to 
those search results. You provide a list of searches to run and the tags to apply to files 
that match those searches in a plain text file. 

Resync 
Will cause Loopcloud to check for updates to your own content. This is done 
automatically unless Scan folders on startup is disabled in preferences. 

Checkpoint local database WAL & Deep clean local database (Vacuum 
and truncate WAL) 
Only use these features if requested to do so by support. 

Show complete product list 
This will start a new search showing every pack we have available in the store. This will 
take some time to load. 

Mac: ⌘ + Shift + R  Windows: Ctrl + Shift + R 

Show user library folder 
Opens your library. 

Clear caches 
Different caches containing information such as recently previewed files, are kept on the 
system. These are automatically cleared every few days but use this to manually clear if 
you are finding the app to perform particularly slow. 

Run diagnostics 
If you feel that there is something wrong with your software, use this to run some basic 
tests and ensure that everything is in order. After running, should an issue be flagged, 
this will be very useful to the support team in order aid them in solving your issue. 

Window size 
Changes the resolution of the app to two separate sizes (small and large) 

Create your own colour scheme 
If you go to Edit colour scheme from the menu, a new window will open. This will have a 
list of all the panels and icons in Loopcloud alongside a colour selector. 

The list of options is defined by area of the app and then a breakdown of specific parts of 
the area. 

For example, filterToolbarBg changes the background colour of the filter toolbar. 

Once you have found the area you would like to change, use the colour selector (or 
paste the HEX) to change the colour and see the colour change. 

If you’re happy with the colour, then use Identify to apply the colour to that feature. 
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This will also provide the code for that colour (HEX) you can copy this using Copy HEX to 
transfer the same colour to other areas of the app. 

Force products database refresh 
Only use this feature if requested to do so by support. 

Find tag UUID in Loopcloud 
Find the tag you want in the tag manager.  Right click while holding alt and select Copy 
uuid to clipboard. 

Copy UUID of an item 
alt + right click on an item in the results view will allow you to: 

Copy UUID to clipboard – copies the product UUID to clipboard 

That are particularly helpful with getting more information for support queries. 

Cancel automatic login 
During application startup alt+shift will show the login window. 

Tag keyboard shortcuts 

You can assign tags to shortcuts for fast tagging.  Pressing the shortcut key will 
automatically assign the tag to the selected files. This is useful for tags that you use a lot. 

For example, let’s say that you are working on a track and you would like to create a tag 
that groups all the files you’d like to use together using a tag you made called ‘trackA’. 

You would then right click on the ‘trackA’ tag in the Tag Manager and Set shortcut, then 
select a key from the list i.e. F.  

Then, every time you come across a file that you would like to use in the track just press 
the F key on your keyboard and the ‘trackA’ tag will be applied. 

You can also do this with groups of selected files or folders in order to apply the tag to a 
batch of files. 

Custom automatic tagging 

There are two options: 

• A manual run of the bulk tagger 
• Automatic rules applied whenever new files are imported.  

In both cases a text file containing the rules is used.  The format is the same in both 
cases.   

Bulk Tagger 
The bulk tagger allows you to repeat a list of searches and apply tags automatically to 
those search results. You provide a list of searches to run and the tags to apply to files 
that match those searches in a plain text file. 

The bulk tagging supports the full search syntax described above.  You can access it by 
holding down alt and clicking the menu in the top right. 
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File Format 
Create a file in a plain text editor like Notepad.  The file contains multiple lines, each 
starts with a search query, and is followed by one or more comma separated tags to 
apply: 

<search query>,<tag>[,<tag>,<tag>...] 

For example: 

regex:.*DRUMLOOP.*,Loops,Drum Loops 

Will tag everything with DRUMLOOP in the file name with the tags Loops and Drum 
Loops.  You can have multiple lines in the file, for example: 

_A_,A 

_B_,B 

_C_,C 

Might be useful for tagging all the keys in a well named bunch of files (e.g. 
PIANO_A0.WAV, PIANO_B3.WAV) automatically. 

Save the file as a .TXT file. 

Lines starting with // are ignored by the bulk tagger and can be used for comments, e.g. 

//_A_,A 

// This rule never worked. 

_B_,B 

BPMs can be set using the bulk tagger, use this format: 

<searchstring>,bpm:<somebpm> 

For example: 

_120_,bpm:120 

_121_,bpm:121 

Loopcloud though now has an auto-bpm tool which does further analysis to improve the 
accuracy, so you are unlikely to need this feature. 

Tagging on import 
The tagger uses embedded rules when importing files.   

It is possible to add additional rules but not to override the existing internal rules. 

The replacement or additional rules need to go in the User data folder in a subfolder 
called ‘rules’. 

{user data folder}/rules/my_new_tags.txt 

The format is the same as for the bulk tagger.  You should restrict yourself to filename 
and regex tagging rules though as when files are important, they will not necessarily 
have bpm or tag information when these rules are run. 
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Files and Folders 

Loopcloud stores data in the following locations: 

 
Mac Windows 

User data folder 

Contains the 
log files, 
configuration 
files etc. 

~/Library/Loopcloud/ %HOMEPATH%/AppData/Roaming/Loopclo
ud/ 

User account 
data folder 

Contains the 
local.db and 
server queue 
database 

~/Library/Loopcloud/<userna
me-without-@-sign> 

%HOMEPATH%/AppData/Roaming/Loopclo
ud/<username-without-@-sign> 

Supporting 
Files 

/Library/Application\ Support/
Loopcloud/ 

c:\ProgramData\loopcloud 

Executable 
directories 

/Applications/Loopcloud.app C:\Program Files\Loopcloud 

VST plugin 
location 

/Library/Audio/Plug-Ins/VST C:\Program 
Files\Steinberg\VSTPlugins\ *may be 
different 

Audio Unit 
plugin location 

/Library/Audio/Plug-
Ins/Components 

NA 

AVID Protools 
plugin location 

  

 

Preview Folder Location 
The preview folder caches recently used preview files.  They are deleted after a few 
days.   

Library Folder Location 
The library folder is shared between user accounts.  You can see the current location of 
the library folder in Preferences.  On Windows we put the folder in the root of the hard 
drive because maximum path-length can be easily exceeded otherwise. 

Windows and Mac file name issues 
Mac and other UNIX based systems only prohibit two characters in filenames ‘/’ and the 
NUL characters.  
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Windows prohibits:  

• < (less than) 

• > (greater than) 

• : (colon) 

• " (double quote) 

• / (forward slash) 

• \ (backslash) 

• | (vertical bar or pipe) 

• ? (question mark) 

• * (asterisk) 

As well as number of special reserved file names.  

If you have used these in sample libraries, you should rename your files before importing 
them into Loopcloud if you intend to ever share your library with a Windows computer. 

Performance 

Loopcloud search and browsing performance is critical.  If something goes slowly, we 
are interested in making it faster.  However, it always helps to have a fast computer. 

We have tested the following and consider performance acceptable: 

• 40,000 sample sized library on 

o Our basic system: A Lenovo i3 with a magnetic 5400 rpm hard disk.  There 
are some pauses, but it is very usable. 

• 400,000 sample sized library (450 products) on 

o A 2016 MacBook Pro with an SSD - searches are almost instant. 

o Our legacy studio system: A 2008 Mac Pro with SSD.  Searches take 
around 4 seconds. 

o A middle of the range laptop: Windows 10 SSD based Intel i7 from HP.  
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